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0.1 03/10/2022 Initial draft versions not released for review N/A 

0.2 06/10/2022 New draft version with amendments following the document N/A 
being used in a training session. 

0.3 07/10/2022 Typo corrections. N/A 

0.4 20/10/2022 Further amendments identified during KT session N/A 

0.5 09/11/2022 New Section 2.8 Creating the POL All Live Defects Report has N/A 
been added that details the instructions for creating the POL All 
Live Defects Report 
No other changes have been made to this document other than 
what has been detailed above. 

0.6 11/11/2022 Added an instruction for new potential or confirmed Defects to N/A 
add the "Date first logged at HDR (dd/mm/yyyy)" as the date of 
the HDR Meeting that this will be presented to POL for the first 
time. 

0.3 Review Details 
See POA Reviewers/Approvers Matrix (P4rv, u'frCN/0001) for guidance on completing the lists below. You may 
include additional reviewers, if necessary, but ycu should generally not exclude any of the mandatory reviewers 
shown in the matrix for the document type you are authoring. 

• (date by which comments should be returned) 

• (author's email) + POA Document Management 

If presented, you can delete the following Mandatory and Optional reviewer tables and paste in the appropriate list 
copied from POA Reviewers/Approvers Matrix (PGM/DCM/ION/0001). 

(* ) = Reviewers that returned comments 
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References should normally refer to the latest approved version in Dimensions; only refer to a 
specific version if necessary. 

®. 

PGM/DCM/TEM/0001 See note See note above POA Generic Document Template Dimensions 
(DO NOT REMOVE) above 

PGM/DCM/ION/0001 POA Document Reviewers/Approvers Dimensions 
(DO NOT REMOVE) Role Matrix 

Alphabetical order 
please 

SVM/SDMIPRO/4317 Latest See Dimensions POL Horizon Defects Review Terms Dimensions 
of Reference 

SVM/SDM/PRO/0875 Latest See Dimensions Application support Strategy Dimensions 

CS/MAN/011 

Alphabetical order please 

HDR Horizon Defect Review 

Horizon Defect Review— Financial Impact HDR-FIN 

HDR-EXP Horizon Defect Review — SPM Experience 

SPM Sub Post Master 

PBS Payment and Banking Service 

PROD OUT Production Out Date 

SME's System Matter Experts 

HTML Hyper Text Markup Language 

PNG Portable Network Graphics 

JPEG Joint Photographic Experts Group 

CBIF Customer Business Impact Forum 

POL Post Office LTD 

MGT Management 

TfSNow TRIOLE for ServiceNow 

PEAK Peak Incident Management System 
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0.0 Accuracy 
Fujitsu Services endeavours to ensure that the information contained in this document is correct but, while every 
effort is made to ensure the accuracy of such information, it accepts no liability for any loss (however caused) 
sustained as a result of any error or omission in the same. 

09 Information CIassificatoni 
The author has assessed the information in this document for risk of disclosure and has assigned an information 
classification of FUJITSU CONFIDENTIAL (INTERNAL USE ONLY). 
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This document describes the way in which the various internal and external Defect Management reports 
are produced for LIVE Defects including branch impacting. It can be used as a procedural document that 
can be referred to and updated in line with changes and/or improvements that are made to the Defect 
Management reports as they evolve and change owing customer or internal requirements. 

w i 

• M. 
• If the Live Incident or Live Defect affects, or could affect, branch operations, we share it with 

POL in a weekly HDR Report and at the Horizon Defect Review (HDR) weekly meeting 

I =MI •. • . Ii tó 

• The Defect Management reports are produced for internal and external distribution in order to 
demonstrate Fujitsu's management and communication of the LIVE affecting defects including 
those that have a branch impact. 

• The LIVE affecting defects reported to POL will have one or more of the following collections 
added in order to qualify as a candidate for reporting: 

o ##LiveAffectingDefect 

o HDR-FIN — Horizon Defect Review — Financial Impact 

o HDR-EXP — Horizon Defect Review — SPM Experience 

• These Defects could be in various stages whilst reporting on them to POL: 

o INVESTIGATING - A Live Defect will start out as a Potential Live Defect until sufficient 
investigation has taken place 

■ [Fujitsu internal unless linked to a bonded Incident] 

o SOLUTIONING - If a fault is confirmed then this will progress to be a Confirmed Live 
Defect (if it is not a fault then the Potential Live Defect will be closed) 

■ [Fujitsu internal as a solution still needs to be identified and agreed] 

o PROPOSED FOR - Once a solution is identified for a Confirmed Live Defect it will need 
to go through the POA processes before the fix is assigned to a sensible Release 

• [Fujitsu internal involving developer / feature conflict check. Counter defects are 
discussed with POL] 

o TARGETED AT - Releases are then managed through to deployment to Live 

• [Visible to all parties as the Release work starts] 

2 Live Defect Management Reporting 

2.1 Week y HDR Report Creation Work Instructions 
© Copyright Fujitsu 2022 FUJITSU CONFIDENTIAL (INTERNAL USE Ref: SVM/SDM/PRO/4695 ONLY) 

Version: 0.5 
UNCONTROLLED WHEN PRINTED OR Date: 09-Nov-2022 

STORED OUTSIDE DIMENSIONS Page No: 6 of 7 



FUJO0232859 
FUJO0232859 

0 POST OFFICE ACCOUNT DEFECT MANAGEMENT REPORTING 

FIJJ1fSU FUJITSU CONFIDENTIAL (INTERNAL USE ONLY) • • 

To create the weekly HDR Report, which is shared with POL, follow these steps: 

The criteria to be used to determine HDR reporting candidates to share with POL will be 
determined by creating a list using the following logic. The resulting list allows for the HDR 
candidates to be identified. 
Prepare the report to send to POL 

• A spreadsheet format has been used to date so the previous week's POL "HDR Defects 
update report — dd.mm.ccyy v1.0.xlsx" submission should be used as the basis for the 
new report — removing all previous week highlighting and deleting rows scored out as 
POL have been told these are being removed. 

• Save the file as vO.1 initially and use v1.0 for the version that is shared with 
POL. As a visual reminder add WIP into cell B2 and lastly delete the "HDR 
Report" Tab, which contains last weeks extracted data. 

■ It may be easier to create several draft versions i.e. vO.1, v0.2, v0.3 etc during 
the creation of the report, so that it is in a state suitable to create v1.0 to share 
with POL. 

■ Amend the date in F3 making sure to leave it as a text field or the title of the 
section below it will not render correctly 

Create the Peak extract to build the report from 
• Then, open any version of the "Peak_Defect—Management extract dd.mm.ccyy 

hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab 
"##LiveAffectingDefect" and click Refresh All. The password to run the embedded 
queries needs entering 3 times and is ? IRRELEVVANT. Save the resulting file with the 
timestamp to match when the extract was created — so it can be referred back to. Turn 
off AutoSave 

Quick filtering method: 
Go to the "HDR Report Pivot" tab 

Right mouse click on any part of the filter values at the top and choose "Refresh" 

PROD OUT Planned 
Response Category 
status 

HDR Classification 

Deferred 
PBS Project 

Date (MLiCaltbn _111 A A % ? 
(ML 

B I ~` 4 0 .na 
ML 

00 -»n 

lh• St top 

(All  ~7 O'PY 

(All fl FomatCoBs... 
mT 

Check that all the filters are accurate and match the description shown 
REFRESHIIOLive All ertingDefeu TAB THEN REFRESH THIS PIVOT AND CHECK THE FILTERS AS SHOWN

PRODGUT Planned Date (Multiple Items) -T' Check PROD OUT Planned Date only ticks the blanks andfjture dates 

Response Category (Multiple Items( -1.. Check the NFF Response Categories are all unticked 

Status (Multiple Items( -T Untick C

HDR Classifiration (Multiple Items(  rSPt to Impart and Expertence(Frrnrr.sods looking at, blankisexcluded( 

Deferred (All) - Set to Yes of blank 

PBS Project (All) -!Set to Yes m blank ..._. ........ ....._. ,. _. 
Double click the number shown to expose the result set for reporting& rename the tab to Deferred/PBS/Other 

CountofSummary _.. . _ _. .. 
59 
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• Ensure that you have set Deferred and PBS Project to (All) 
• Pay special attention to the "PROD OUT Planned Date" which may have had new future 

dates added that need to be ticked 
Call Type Defect Identified T S 

PROD OUT Planned Date_ (Multiple Items) r  S 

Respor :Search 0 I. 

Status 
o 19/l11/2021 E 

HDR Cl: 1... © 03/04/2022 `-
Target , 003/02/2022 E 

BIF Plai .012/02/2022  E 

PTF Pla I?J2310212022 S 

BIF_Tic -X16/032022 E 

Actions _.❑ 11/02/2022. S

R 31/03/2022
1701/05/2022 

Count

Sselect Multiple Items 

OK Cancel 

o List — Deferred, Project and HDR Live Defect Peaks 

PROD OUT planned Date (Multiple Items),. 

Response Category (Multiple Items) 
Status (Multiple items) -T6 

HDR Classification (Multiple Items) ,Tl: 

Deferred (All)

PBS Project (All) 

• If there are any Deferred, Project and HDR Peaks to consider, a number will appear 
under the Count of Summary 
Count of Summary 

30 
o Double click on the number to open a new sheet with the relevant Peak(s) listed 

and rename it "HDR Report". 
O It is more likely that the result set largely matches the previous results showing 

in the HDR Report. 
o Compare the previous HDR report to the new list and amend accordingly so the 

new HDR report list matches what the system now shows 
o To do this it is worth hiding the following columns as it makes to easier 

to compare the data against the previous HDR Report: 
■ C — Date Opened 
■ D — Product 
■ E — Product Group 
■ G — Priority 
■ H — Assignment Team 
■ I — Status 
■ J — Response Category 
• K — Root Cause 
• M — References 
• N — TfSNow Reference 
• 0— POL SNOW Reference 
• P — Contact Name 
• R — Business Impact 

• It is good idea to mark for each Defect PEAK the "Call Reference", "Description", "Target 
Release Type" and "Target Release" red on the HDR Report tab of the 
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"Peak_Defect_Management extract dd.mm.ccyy hh.mm.xlsx" once checked against the 

previous HDR Defects Update Report dd.mm.ccyy.xlsx. 

Also check column AH "Planned Out Date'" to ensure that any dates previously reported 

against in the HDR Defects Update Report under "Current Target Release Date" have 

not been amended or if any new dates have been added for Defects that had previously 

been blank. 

If any dates have been amended or added, then please add to the Current Target 

Release Date of the HRD Defects Update report and add a new HDR extract. 

Also check column AG Date Time Last Updated to see if any Defects have been 

updated in the last week. If so, check the Defects to identify the changes and if the 

Impact Tab has been updated then please add to the HDR Report. Other updates such 

as comments added to the Detail Tab may not require to be communicated to the 

customer as this could a JIRA reference or log needed to further investigations. 

PC03023I3 DEV - PIN Pa Defect ldent##UveAffectir No The PIN Pad status Proposed For HNG-X 73 10 
PC0301681 SV&L T2.30:E Defect (dent HDR-Fin, ##LivYes During Existing Rev Reported in 14N6-X R i Ind i 

PC0301437 Transaction Defect Ideni HDR-Fin,##LivYes If a counterperforrTargeted At HNG-X7230 
PCO301364 015 reports , Defect Iden:HDR-Fin, ##LivYes Aftera failed stock Targeted. At HUG-3 72.30 
PC0301299 BAL fix- INC Defect ldeni .SSC3rd, a#LiviYes Ifa clerk uses the T Targeted At HNG-X 38.04 
P70101174 Custo" er or Defect Ident HDR-Fin, ##LivYes During this baskets Props<ed Fnr, HNG-X 73.10
PC030040+1 DES✓ Transa Defect ldent##LiveAffectinNp If Transaction Logs Targeted At HNG-X 72.30 
PC0300338 Courter Fix . Defect Ideni.SSC3rd, ##LivcYes Ifa clerk uses the T Proposed For HNG-X 73.10 

PC0300066 PBS: INC102: Defect (dent HDR-Fin, ##LivYes Declined transactio Reported In HNG-X Rel• Ind, 
c029978: 

_ 
'BS Barking Defect Iden' HDR-Fin, ##LivYes This issue is the res Targeted At HNG-X 72.30 

PCO299322 Branch 2508: Defect Iden' HDR-Fin, ##LivYes AP Transaction (Aul targeted At HNG-X 37.01 
P0229189.1 PBS C7rnple Defect Idenre eliveAffectirNo Ifa PBS Balance Ent nr r :,o"r- t For HNG-X 73.10 
P00298823 PBS: Regress Defect Ident HDR-Fin, ##UvYes In rare cases, pre  t HNG-X 72.20 

PCO298591 PBS trarsact Defect Ideni HDR-Fin, .SSCFYes If the user presses a- .- ",t HNG-X 72.20 
PCO298324 PBS Counter Defect ldeni.SSCRandR, ## No On PBS counters wlTarget .',t HNG-X 72.20 
PCO298067 LST:R71.10 - Defect Ideni##LiveAffectir No Business impact: A Pro: _,:- -or HNG-X 73.10 
PCO297965 LST:R71.10- Defectldent##LiveAffectirNo Business impact: If ProposeuFor HNG-X73.10 
P10297964 LST:R71.10- Defect ldenl##LiveAffectirNo During Existing Rev Proposes For HNG-X13].0 

PCO297963 LST:R71.10 -? Defect Iden1 ##LiveAffectirYes There have been n' Proposed For HNG-X 73.10 
PL0297962 LST:R71.10 - Defect Ident##LiveAffectirNo Existing Reversals s Proposed For HNG-X 73.10 
PCO297878 PBS LST:R71, Defect Ident BIFApproved, No When a PBS bankinlargeted At HNG-X 72.20 
PCO295854 LST: 870.40 C Defect Ident BIFApproved, No PBSIL does not imp Proposec For HNG-.x 73,10 

PCO254925 Obsolete He Defect IdeniSattars, .SSCCE No When help pages hTargeted At HNG-X 72.20 
P03293665 CBB-5606 - L. Defect (dent ##LiveAffectir In particularly rare i Proposed For HNG-X 73.10 

P13293598 170.40: I TO Defect (dent BIFApproved, No 
'fir  

,-„': For AP-ADC transac Targeted At HPAG-X 72.20 
DCO292825 INC7179929 Defect Iden'SSC- 4th Line, No See Title. this is be Proposed For HNG-X 73.111 

PCO292708 CBB-5259 - H Defect Ident BIFApproved, The history text ge+Proposed For HNG-X 73.10 

P03290005 LST:REL_IND Defect Ident BlFApproved, No When the Clerk alt Proposes For HNG-X 73.10 
PCO289922 LST: 870.20 C Defect IdeniBlFApproved, Yes 3778313,« During a Rem Info Proposed For HNG-X 73.10 
200289327 070 20-WAS Defect tden±BIFApproved, For some backoffiRTa ge ed At HNG-X 72.20 

Any that have been closed should be moved to the HDR Closed Defects section of the 

HDR Report and highlight in yellow: 
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• Any that are new should be added to the list and highlighted in red on the HDR Report 
tab whilst they are checked and completed 

o These then need scrutiny to ensure they look correctly tagged as HDR. 
This will require the Peak to be read and checked 

o If they are HDR, then the Impact tab needs checking to ensure it is 
complete and reads well. Any amendments should be referred to the 
SMEs for updates to be added to Peak 
F 'th' ttevtl ]Ve AffébfingHDRPëlCis still under investigation and such 
details as RCA, Fix, etc, have not be identified it is advisable that on the 
impact tats', at the start of the description field the following is added 
"EARLY NOTIFICATION".

o This enables Fujitsu to inform Post Office of a new defect whilst its still 
being investigated and confirmed to be a defect. 
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o Ensure that the Date first logged at HDR (dd/mm/yyyy) is completed 
with the date of the next meeting (normally a Monday) for which this 
potential or confirmed new Defect will be presented to POL in the HDR 
meeting. Field from the Impact Tab illustrated below: 

Date first logged at HDR (dcUnun yyyy) 24/10/2022 

When the report is ready to submit, the highlighting on the new rows 
should be changed to yellow 

Extract the list showing: 
HOP. Defrts 

o POL Reference (from column BI) 
o POL Title (from column BN or set to N/A for a new entry) 
o Category (from column BF) 
o Fujitsu Reference (the Peak Call Reference from column A) 
o Summary (the Peak Summary field from column B) 
o Confirmed Defect (set to "Yes" if Call Type in column F is "Defect 

Identified" or "No" otherwise) 
o Workaround (from column 0) 
o Update (manually updated to pick out any changes made week to week 

on the Peak in question — if nothing has changed (as is typical once a 
Peak is Targeted At) then the "No change since dd/mm/ccyy" will 
probably be ok to leave as is. If any updates are identified, set this cell 
to YELLOW FILL 

o Target Release Type (from column S) 
o Target Release (from column T) 
o HDR Extract 

■ Create the file to embed: 
This is created within Peak from the Impact tab 
Open the Peak and go to the Impact tab 

IS 

T [ um Ci...iv F u cmfdmn!-f ul m4.wfiLm~. 

• Click on the Export icon on the top right 

• A view of the Impact screen is presented in a new window 
• Right mouse click and choose "Save as" 
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■ Save the file 
o Embed the file 

• Click on the cell into which the saved HTML file is to be 
added 

• Click on the Insert menu option at the top 

orne Insert Page Layc 

• Click on Object in the Text section 

" WordArt 

t  ! 

1 r

J Signature Line
Text Header 
Box & Footer Object 

Text 

■ Click on the "Create from File" option on the screen that 
appears 

ob;Et ? X 

Create t1e eate N nr  File ....._::  - % : 

File namee 

❑ tin* tattle 
Q Dicpi as icon 

Result. . .

Inserts the contents of the file into your 
document so that you can edit it later '..
using the program which created the 
source lge. 

UK i Cann 

• IIICK on browse ano inen navigate to ana CIICK on ine 

relevant file and select "Insert" 
■ Then click OK 
• The file will be inserted into the cell in the HDR report 
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o Screenshots 
■ If any screenshots have been requested or are needed, first 

save the screenshot to a file (PNG or JPEG) 
o Embed the file 

• Click on the cell into which the saved HTML file is to be 
added 

• Click on the Insert menu option at the top 

ome Insert Page Layr 

• Click on Object in the Text section 
WordArt -

fk, 

Text Header 
i Signature Line 

Box & Footer Object 

Text 

■ Click on the "Create from File" option on the screen that 
appears 

Object ? X 

Create New Create from File 

File name: 

Q Link to file 

n 

Display as icon 

Result_ . . ... .. .. ., 
Inserts the contents of the file into your 
document so that you can edit rt later 
using the program which created the 
source file. '..

OK j Cancel 

■ Click on Browse and then navigate to and click on the 
relevant file and select "Insert" 

■ Then click OK 
• The file will be inserted into the cell in the HDR report 
■ If it is a PDF document, you will need to click on Display as 

icon checkbox 
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? X 

Ctt * trot file 

fie e 

i e,*ui+~sWaruaaz~~oAsoa're aH y~t aeyort mop=r ! 

o Lii to (tie 

mete to an icon that reptee,M.s the contents of 
the He into your document, 

Pc oe3G4-pda 

Chanye gon... 

r iii Can[ld 

o Click OK and then resize the PDF document in the cell 
o Once all details are added please ensure that all the row illustrating the 

new Defect is highlighted in yellow. 

FYI ONLY — MANUAL FILTERING 
o If the HDR Report Pivot is absent or corrupted, then the manual filtering is as follows 
o Go to the ##LiveAffectingDefect tab and filter as follows: 

• Set the filter on Response Category [column J] to exclude the No Fault Found values 
(see Appendix A) 

• Set a filter on HDR Classification [column BF] to exclude blanks 
• Set a filter on Planned Out Live [column AH] so the dates are in the future or blank (it 

has not been deployed) 
• Exclude closed Peaks where Status [column I] is "C" — as these may have been fixed 

outside of a release by Ingenico themselves 
o Then the 1 List needs to be created that can be used to compare against the previous week's 

report: 
o Deferred Live Defect Peaks 

• Set the filter on Deferred [column BH] to "Yes" 
• These are unlikely to be discussed at HDR as they are previously approved and 

understood but are provided to show the level of Fujitsu control 
o Project Live Defects 

• Set the filter on PBS Project [column BG] to "Yes" 
• These are unlikely to be discussed at HDR as they are part of the ongoing Project 

Manager regular review calls 
o Non-Project Live Defects (likely originating from an Incident during normal service delivery) 

• Change the filter on PBS Project [column BG] to exclude "Yes" 
• These require more comprehensive information as these will be discussed at the 

HDR meeting 
• Extract the list as described above 

o These previously were listed as individually in their own sections but is now reported all together. 
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A.1 22 WeeklyCBIF ubmission Extract Work Instructions 
To identify if there are any CBIF submissions necessary to POL, follow these steps: 

Create the Peak extract to build the report from 
Open any recent version of the "Peak_Defect_Management extract dd.mm.ccyy 
hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab and click Refresh 
All on each tab. The password to run the embedded queries needs entering 3 times and 
is [IRRELEVANT  Save the resulting file with the timestamp to match when the extract was 
created — so it can be referred back to. Turn off AutoSave 

o Quick way 
Go to the "CBIF Peaks Pivot" tab 

Right mouse click on any part of the filter values at the top and choose "Refresh" 
Call Type Defect Identified I.T Set to D 

PROD OUT Planned Date (Multiple Items) X Set to ft

Response Categor Cakbrt p Q A % 

Status 
81 rNOR Classification 

Target Release Tyr' rt.- na..N.ht r.^.^~L V c,a„a,t

BIF Planned Date L0 &OPY 

PTF Planned Date [armat Cel!s.-,

BIF_Ticked_Quest — --- --- -; 

ActionedTeam [?!t Eef' 5' 

Most
Count of Summate 

X P.emove "Target Release Type" 

r*  FieldSettings._ 

P,,otlable options._ 

Hide Field list 

Check that all the filters are accurate and match the description shown: 
REFRESH a#LiveAHectingDefect TAB THEN REFRESH THIS PIVOT AND CHECK THE FILTERS AS SHOWN'. 

Call Type Defect Identifies -T Set to Defect Identified 

PROD OUT Planned Date (Multiple items) -T Set to future date or blanks 
Response Category (Multiple Items) T  Untick the No Fault Found categories 
Status (Multipleltems) -T. Exclude C 
HDR Classification (blank) .T Set to blanks 
Target Release Type (Multiple Items) ;S Exclude Targeted At 
RIP Planned Date (Multiple Items) -T Exclude blanks 
PTF Planned Date (blank) 

.T. 
Set to blanks 

BIF_Ticked_Questions (Multiple Items) .T' Exclude blanks 

Actioned Team (blank) T' Set to blanks 

Double click the number shown to expose the result set usually nothing; 

Count of Summary 

Pay special attention to the "PROD OUT Planned Date'" which may have had new future 
dates added that need to be ticked 
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Call Type Defect Identified .T 5 
PROD OUT Planned Date (Multiple items) -Y 5 

Respor ,- L 
Status :r i 9/01/2021 '.n 'E 
HDRCI: !...803/04/2022 S 
Target :-003/022022 E 

BIF Plat ❑ 12102/2022 E 

PTF Pla 23/02/2022 S. 

BIF Tic L I 16/03!2022 E 
Actione Ii ?1/02/2022 ,....... 

31/0312022
R 01/0512022

Countt 

0 Select Multiple Items 

OK Cancel 

• If there are any CBIF Peaks to consider, a number will appear under the Count of 
Summary 

Count of Summary 

O Double click on the number to open a new sheet with the relevant Peak(s) listed 
O Go to "Collating the results" below 

O Manually filtering way 
• Go to the ##LiveAffectingDefect tab 

• Call Type [column F] is "# - Defect Identified" (a fix is needed) 
• Set the filter on Response Category [column J] to exclude the No Fault Found values 

(see Appendix A) 
• Set a filter on HDR Classification [column BF] to blanks 
• BIF Planned Date [column U] must not be blank (it has to have been to a BIF meeting) 
• Target Release Type [column S] is not Targeted At (as this means it has gone through 

PTF already) 
• PTF Planed Date [column AA] must be blank (it has not been to PTF) 
• Planned Out Live [column AH] date is in the future or blank (it has not been deployed) 
• The Actioned Team [column AJ] must be blank (i.e. not BIF (not ready for CBIF) or PTF 

(gone past the CBIF step)) 
• BIF_Ticked_Questions [column AM] is not blank (BIF selected it for CBIF) 
• Go to "Collating the results" below 

o Collating the results: 

• Check that each Peak(s) in the result set is/are correctly marked by reviewing the Peak 
Details and looking at the Release Management (Release MGT) tab for notes that 
clarify. Any Peaks that are confirmed as CBIF candidates then need a CBIF Proposal 
creating as this is what will be submitted to POL. 

• CBIF is part of the HDR meeting and any proposals should be submitted along with the 
weekly HDR report for discussion at the weekly HDR meeting with POL. 
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A.2 Appendix A — No Fault Found Response Category values 
Peaks with the following Response Categories are deemed to be No Fault Found as no action was 
required to remedy the issue raised. In some cases this is because the fault is within an area of the 
system that is managed using TfSNow and hence Peak is not the source of the Live Defect information. 

Response Category - 68 -- Final -- Administrative Response 

Response Category - 95 -- Final --Advice after Investigation 

i Response Category - 94 -- Final -- Advice and guidance given 

Response Category - 70 -- Final -- Avoidance Action Supplied

Response Category - 200 -- Final -- Call withdrawn by user 

Response Category - 120 -- Final -- Cloned to create Defect Peak 

Response Category - 72 -- Final -- Duplicate Call 

Response Category - 58 -- Final -- Documentation Fix Available to Call Logger 

Response Category - 66 -- Final -- Enhancement Request 

Response Category - 96 -- Final -- Insufficient evidence 

i Response Category - 62 -- Final - No fault in product 
I Response Category - 63 -- Final -- Programme Approved - No Fix Required 

i Response Category - 64 -- Final - Published Known Error 

Response Category - 100 -- Final -- Route call to TfS 

Response Category - 97 -- Final -- Unspecified insufficient evidence 

Response Category - 98 -- Final -- User error 

23 Updating the PIVOT Tab of the Weeky Defect Update 
Report 
The Pivot tab of the Weekly Defect Update report provides a table and graph that illustrates 1) 
The Proposed For 2) Targeted At 3) TBC for the Defects displayed in the HDR Report - Open 
Defects by Target Release and HDR collection i.e. Impact and Experience. 

If no new defects are added to the report, then the table and graph can be refreshed to pick up 
any changes by following the below steps: 
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• On the Pivot tab, select a cell within the table and then right click, to bring up the menu 
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• On the menu click on refresh to update the table and graph 
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• If new defects have been added to the HDR Report — Open Defects, then select the 
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• Then select Change Data Source from this meu click on Change Data Source 

'!W$ JniCi! Vye iq Fminul6s;"Yfefe Rewaw"~; V~r Hen ':!~Yiidq'4H__

r L 
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. The Change PivotTable Data Source menu will be displayed 

POST 
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. Change the Table/Range to cover all the active rows and then click ok 

This will then return you to the Pivot Tab 
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. Again it is worth refreshing the table. 
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' .• • • • • . * ' ! I11I Questions .. • Lilt. 

As a result of the weekly HDR meeting there maybe questions raised by POL that you will need 
to read the Defect PEAK or engage the required technical resource to gain the required updates 
to add to the Impact Tab so a revised HDR Extract can be provided in the next HDR Report. 

Additionally, POL may send questions on HDR Defect PEAKS in order to gain clarification, that 
will again need to be added to the Impact Tab so a revised HDR Extract can be added to the 
HDR Report. 

These actions can be performed outside of the producing of the weekly HDR Update Report in 
order to be ready to add the report against the appropriate HDR Defect PEAK in the report. 

• Once all the required changes have been added to the HDR Report, you are now in a position to 
create v1.0 to send to POL by approximately 10:00 on a Friday morning, in preparation for the 
HDR meeting with POL on a Monday morning (Usually 11:45). If you send it a little late owing to 
awaiting an update from a technical resource, that is not a big issue as long as it is sent to POL 
by close of play on the Friday. 

o Open the latest draft version of the report i.e. HDR Defects Update Report v0.2 

o Ensure that all the required updates, HDR Extracts and Screenshots have been added to 
the report. This includes checking against the actions from the minutes of the previous 
meeting sent by POL in order to ensure that the required information to answer POL 
questions is included in the HDR Extracts for the appropriate HDR Defect PEAKS. This 
will assist in confirming the status of the Fujitsu actions from the previous meeting. 

o If so, remove the word "WIP" into cell B2 and save the report as "HDR Defects update 
report — dd.mm.ccyy vl .0.xlsx" 

o Next prepare the email to be sent to POL that the report needs to be attached to. Please 
see example of the weekly email for the HDR Update Report below: 

From: Hatch, Matthew 
Sent: Friday, September 30, 2. 022 10:12 AM -.-
To: Paul I Smith < GRO ;Lisa_millar GRO 

GRO_._._.; _._._._.__ .BratincelJ._.Steven._._._. 
G_RO ; Bothick, Sandie _._._._._._._._._._._._.GRO >; POA 

Dutymanager 
, 

_._._._._._._._.,GRO.. ..- .--.-.-r--------
Subject: HDR Defects Update Report - 30.09.2022 - v1.0 

Good Morning Paul and Lisa, 

There are NO CBIF candidates to put forward this week and NO NEW DEFECTS to 
raise. 

There is also FOUR updates to the existing entries, that have been highlighted in yellow 
in the update column. 

Changes to report and updates: 

• The pivot has been updated 
• The four updates are: 

0 1 has had the Target Release updated. 
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o 1 has Status Update amended to reflect POL questions 
o 1 has RCA updated etc amended to reflect POL questions 

■ Already provided revised HDR to POL on Monday 26t" of 
September. 

o 1 has the latest problem update. 
• The one closed defect from last week: 

o PC0302653 - Invalid session receipts printed before session settlement 
& user confused as to how to settle it 

■ The HDR extract has been updated to reflect POL accepting 
that this is not a defect and is working as per design, as result of 
meeting held on Wednesday 28th of September. 

There are NO OPEN ACTIONS for Fujitsu — as I have engaged technical resources and 
updated the HDR Extracts for the below: 

• PC0302313 DEV - PIN Pad Record Not Updated To Show When 
Responsive/Non-responsive during logon or unlock 

• PC0302653 Invalid session receipts printed before session settlement & 
user confused as to how to settle it - (closed) 

Meeting held on Wednesday 28th of September as highlighted above. 

I approve the minutes from the HDR Meeting on Monday 26/09 from a Fujitsu 
perspective. 

o Then add the report version 1.0 "HDR Defects update report — dd.mm.ccyy v1.0.xlsx" to the 
email and send to 

In order to have an audit record of the HDR Defect Update reports, emails sent to POL and emails and 
minutes of the meetings sent by POL to Fujitsu, there is a SharePoint location whereby all of these 
emails and documents are held. Following the sending of the weekly report to POL, or responding to 
POL emails with questions or the receiving of meeting minutes from POL please save them to the below 
SharePoint location: 

Service Management - Horizon Defects Review (HDR) - started June 2021 - All Documents 
(sharepoint.com) 

To create the monthly Live Defect Management for POA stack owners and leadership, follow these 
steps: 

o Create the Peak extract to build the report from 
• Then, open any version of the "Peak_Defect_Management extract dd.mm.ccyy 

hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab and click Refresh 
All on each tab. The password to run the embedded queries needs entering 3 times and 
is IRRELEVANT  Save the resulting file with the timestamp to match when the extract was 
created — so it can be referred back to. Turn off AutoSave 

o Prepare the report 
• A spreadsheet format has been used to date so the previous month's 

"POA_Live_Defect_Management Monthly Report dd.mm.ccyy hh.mm.xlsx" should be 
used as the basis for the new report. To show history, copy the white box on the top left 
of the Summary tab and paste it to the right as an image (you may need to delete a 
previous image) 
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Save the file with the same date and time values as the Peak extract created earlier so 
you know which extract the report relates to 

o Go to the ##LiveAffectingDefect tab and filter as follows 

Then the 5 tabs are derived as follows: 

Check the range of values in the Call Type column. If there are any that are neither "Live Incident" 
nor "Defect Identified" then these need to be looked at to decide whether to treat them as one of 
these 2 categories. There shouldn't be any, but if there are, it is most likely to be Vulnerability which 
can be treated as Defect Identified. If so, amend the filtering below where ** is shown. 

o Still Investigating 
• Clear all filters 
• Filter the Planned Out Live date so it is in the future or blank (it has not been deployed) 
• Filter out the No Fault Found Response Category values (see Appendix F) 
• Filter Call Type to "Live Incident" ONLY ** 

• Consider filter on Status to exclude "C"losed — but beware the closures may be 
wrong 

• Extract the columns shown on the tab from the filtered list and paste the values into the 
report 

• Expand/contract the Stack owner column by copying/pasting the formula so all rows are 
attributed to a name 

DI — Solutioning 
• Clear all filters 
• Filter the Planned Out Live date so it is in the future or blank (it has not been deployed) 
• Filter out the No Fault Found Response Category values (see Appendix F) 
• Filter Call Type to "Defect Identified" ONLY ** 
• Filter "Target Release Type" to exclude "Targeted At" and "Proposed For" 

• Consider filter on Status to exclude "C"losed — but beware the closures may be 
wrong 

• Manually add back in any that are "Targeted At" or "Proposed For" and Target 
Release is "Re-target" if there are any 

• Extract the columns shown on the tab from the filtered list and paste the values into the 
report. 

Fujitsu have agreed to create a report called "POL All Live Defects Report" on a fortnightly basis and 
send to POL. 

In order to create the report please following the below instructions: 

1. Run the "Peak_Defect_Management extract dd.mm.ccyy hh.mm.xlsx" update and rename the 
file accordingly 

a. Update the filters on all tabs and Refresh the content 
b. Save the file 
c. Turn off autosave 

2. Create the "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.xlsx" file by copying the 
previous version (the POL report) 

a. Update the Front Page to put the correct dates at the top 
3. Go back to "Peak_ Defect_ Management extract dd.mm.ccyy hh.mm.xlsx" 

a. Go to the Defect Stage Pivot tab and click on the number to the right of Grand Total 
b. This will create a new sheet with all the Peaks on that you need 
c. The columns then need reordering ready for placing into the POL report 
d. In order... 

i. Cut column BJ and paste it prior to column A 
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1. Wrap Text will probably switch on so select all content and put Wrap 
Text back off 

1. Cut column BG and paste it prior to column E 
2. Cut column BI and paste it prior to column F 
3. Cut column T and paste it prior to column G 
4. Cut column S and paste it prior to column H 
5. Cut column BJ and paste it prior to column I 
6. Cut column X and paste it prior to column J 
7. Cut column BK and paste it prior to column K 
8. Cut column BF and paste it prior to column L 
9. Cut column BO and paste it prior to column M 
10. Cut column BV and paste it prior to column N 
11. Cut column BY and paste it prior to column 0 

1. Sort column A A-Z (1 - Investigating will be at the top) 
2. For all top rows where Defect Status is 1- or 2- blank out columns J, K, and L 
3. Filter column BO (Impact:Date of Issue) to dates AFTER the last report AND including 

Blanks - to show only those that have changed since the last report was run 
i. Filter column E (HDR Classification) to blanks only - the HDR ones will have 

been scrutinised already 
ii. Check columns M, N and 0 read well and request amendments if not - apply 

manual edits to this extract to save repeating above steps 
1. Remove filter column E (HDR Classification) and filter column AX to show those 

declared HDR since the last report 
i. Check columns M, N and 0 read well and request amendments if not - apply 

manual edits to this extract to save repeating above steps 
1. Clear the filter to show all rows (Menu - Data - Clear for speed) 
2. Select from row 2 until the end and take columns A-O 
3. Copy the text 

Go back to "HNG-X - All Live Defects Report for POL - dd,mm.ccyy.xlsx" 
a. Place cursor on cell A2 and Paste values 
b. Check that there are no extra rows from the previous report - delete if there are 
c. Unhide the tab "By Release" and Refresh it 
d. Select all contents except the header row and then paste alongside as an image 
e. Crop the image to remove the Pivot table "-" symbols 
f. Cut the image and paste it on the Front Page - resize and position correctly 
g. Hide the "By Release" tab 
h. Save the spreadsheet 
i. Select the entire "All Live Defects" sheet (top left corner left of A and above 1 
j. Double click a row marker to cause resizing to fit contents 
k. Amend the screen so you can see columns M, N and 0 
I. Slowly scroll down the file adjusting any cell heights where content looks to end oddly to 

ensure all content is visible 
m. File Print and select "Print Entire Workbook" 
n. Set printer to "Microsoft Print to PDF" 
o. Check Preview of all pages 
p. Press Print 
q. Save file as "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.pdf" 

Go back to "Peak_Defect_Management extract dd.mm.ccyy hh.mm.xlsx" and delete the sheet 
you manipulated to create the view for POL 

a. Save the file 
b. Close the file 

• On the day of issue, send to Rohit Gogna 1 __- __ __- _GRO _ ~; Paul I Smith 
GRO in POL. 

HNG-X-AU Live 
Defects Report for F 
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• orward_a.copy_of the, Sent_Item to POA recipients: Hatch Matthew _ ._. 1_._._._._._._._._._._._._._._._._._._._._._._._._.. 

Steve (BRA01) L GRID  3>; Duhaney, 
Joan -.-.-.-.-.-.-.-GRo-._._._._._._._._._._._. :E3acon, Rosie ;_,_;:;_;_-:;_;_;: GRo------------------_;_:>: Allen, Graham 
(BRA01) -GRO .- :=:9; Walton, Daniel 4._._._._.E - -GRO _._._._._._._._._._.a:._Evp~, 
Steve (BRAO1) Steve steve.a~evansi GRO Browell, steven 1 CR0 

FW HNG-X-AII 
Live Defects Report 
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